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Tips & Shortcuts in Excel® 2010
 Navigate to a Worksheet  

1. Right-click on the tab scrolling  
buttons and select the worksheet. 

Select Cells 
1. Click on the Select All button to  

the left of column A and above  
row 1 to highlight all cells in the active 
worksheet. 
A worksheet is 16,384 columns and 1,048,576 
rows.  
To select multiple non-adjacent cells, select the 
first cell, press and hold down the [Ctrl] key and 
select each additional cell.  

Select Ranges 

1. Click on the first cell in the range. 
The mouse pointer will display a hollow cross. 

2. Drag to the last cell to highlight the range. 
Or click on the first cell, hold down the [Shift] 
key and click on the last cell or click on the first 
cell, hold down the [Shift] key and press the 
arrow keys on your keyboard. 
To select multiple non-adjacent ranges, select 
the first range, press and hold down the [Ctrl] 
key and drag to select each additional range. 

The Name Box 
 Displays the current cell reference. 

 Type a cell reference in the Name Box 
 and press [Enter] to go to a specific cell.  

 Used to define and select range names. 

Define a Range Name using the Name Box 
1. Select the range and click 

 in the Name box. 
2. Type a name for the range and press [Enter]. 
 Range names cannot contain spaces.  
 The scope defaults to workbook; therefore 

you can reference the range name from any 
worksheet in the file. 

 Click the drop down arrow on the Name box 
and select a range name to highlight a range. 

 Use range names in formulas such as 
=sum(gross). 

Define Range Names from Headings 
1. Select the ranges you want to name including 

the row and/or column headings. 

2. Click on the Formulas  tab and click 
on the Create from Selection

 tool. 
3. Select Top row, Left column, Bottom row, 

and/or Right column and click on OK. 

Apply Range Names to Existing Formulas 
1. Click on a cell that contains a formula that 

you want to apply a range name to. 

2. Click on the Formulas  tab. 
3. Click the drop down arrow on the Define 

Name  tool and select Apply 
Names… 

4. Select the range names to apply and click on 
OK. 

Format Data as a Table 

1. Select the range, click on the Home  tab 
and click on the Format as Table tool in the 
Styles group. 

2. Select a table style. 
 Click in the table to display the Table Tools tab.  

 New adjacent columns and rows are automatical-
ly included in the table; therefore, new data is in-
cluded in charts, range names, and pivot tables. 

 When you enter a formula in one cell, the Calcu-
lated Columns feature automatically applies the 
formula to all other cells in that column.  

Add a Total Row in a Table 
1. Click on any cell in the table and click on the 

Design  tab under the Table Tools tab. 

2. Click in the Total Row check box in 
the Table Style Options group. 
 The total row uses the Subtotals function to sum 

the last column. 

3. Click the drop down arrow  on the 
formula in the total row to select a different 
function. 

4. Click any cell(s) in the total row to add additional 
totals. 
 The Subtotals function in the total row only 

calculates visible cells when a filter is applied. 

Sorting (Single Level Sort) 
1. Verify that the range you want to sort does not 

contain any blank rows and columns and contains 
headings. 

2. Click on any cell below the column headings. 
 If the worksheet contains any data that should 

not be included in the sort, insert a blank column 
and/or row to separate this data from the data 
you are sorting. 

3. Click on the Data  tab. 
4. Click the Sort Ascending or Sort Descending  

tool in the Sort & Filter group. 
 Text options are Sort A to Z and Sort Z to A. 

 Numbers options are Sort Smallest to Largest and 
Sort Largest to Smallest.  

 Dates options are Sort Oldest to Newest and Sort 
Newest to Oldest. 

Multi-Level Sort (Up to 64 levels) 
1. Complete steps 1 through 3 above.  
2. Click the Sort tool in the Sort & Filter group.  

3. Click the Sort by drop down 
arrow and select the column heading of the first 
sort level. 

4. Click the Sort On drop down  
arrow and select the type of sort.  
 To sort by cell contents, select Values. To sort by 

format, select Cell Color, Font Color, or Cell Icon. 

5. Click the Order drop down arrow and select the 
sort order. 

 For text, select A to Z or Z to A; for numbers, select 
Smallest to Largest or Largest to Smallest.  
For dates or times, select Oldest to Newest or 
Newest to Oldest. 

6. Click the Add Level   button and repeat 
steps 3 through 5 to add additional sort levels. 
 You can sort on up to 64 levels in Excel 2007. 

7. Click on OK. 

Resize Columns and Rows 
1. Drag the right boundary of a  

column heading or the bottom  
boundary of a row heading.  
The mouse pointer will display a double-headed 
arrow. 

Or  
Double-click on the column or row boundary 
to resize the column or row to accommodate 
the largest entry. 

Click the Select All button and 
double-click or drag  a column or 
row boundary to resize all columns 
or rows. 

Pound symbols ### display when a cell that 
contains a value or formula is not wide enough. 

Fill a Series 
1. Point to the fill handle in the lower  

right corner of the cell pointer to display the 
black cross and drag to copy a formula or text 
to adjacent cells.  

 You can double-click on the fill handle to fill 
down. Excel will stop at the first blank cell. 

 If Excel recognizes a pattern, click Undo  
and hold down the [Ctrl] key as you drag to 
copy to adjacent cells. 

Fill a Series by Example 
1. Type a number, date, or text in a  

cell. 
2. Type another number, date, or text  into an 

adjacent cell. 
3. Select both cells to highlight the range. 
4. Point to the fill handle in the lower  

right corner of the selected range to  
display the black cross and drag to fill the 
series into adjacent cells. 

Move and Copy with Drag and Drop 
1. Point to the black border of the cell 

pointer or selected range to display 
the Move Pointer and drag to move or hold 
down the [Ctrl] key and drag to copy. 

The Format Painter Tool 
1. Select the cell or range that contains the 

formatting you want to copy. 

2. Click on the Home  tab and click on the 

Format Painter  tool in the 
Clipboard group. 

3. Select the cell or range you want to format. 
If you double-click on the Format Painter tool, you 
can paint multiple times. Click the Format Painter 
tool to turn it off when you are finsihed. 

Clear Formatting  
1. Select the cell or range and  click on the Home 

 tab. 

2. Click the Clear  tool in the Editing 
group and select Clear Formats. 
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Duplicate a Worksheet 
1. Click on the worksheet tab  you want 

to copy. 
2. Hold down the [Ctrl] key and drag the 

worksheet tab to the desired location. 
 Release the mouse button before the [Ctrl] key; 

otherwise you will move the worksheet. 

Group Worksheets 
1. Click on the first worksheet tab  to 

select the worksheet. 
2. To group non-adjacent worksheets, hold down 

the [Ctrl] key and click on each additional 
worksheet tab to include in the group. 

Or to group adjacent worksheets, hold down 
the [Shift] key and click the last worksheet tab 
to include in the group. 

Or to group all worksheets, right-click on any 
worksheet tab and choose Select All Sheets   
from the shortcut menu. 

All the worksheet tabs in the group appear white 
and the title bar displays the word [Group] in 
brackets. 
All actions completed in one worksheet are 
applied to all worksheets in the group. 

Ungroup Worksheets 

1. Right-click on a worksheet tab  and 
select Ungroup Sheets. 

Worksheets also ungroup when you click on a 
worksheet tab that is not in the group. 

Print Gridlines  

1. Click on the Page Layout tab and 
select the Print Gridlines check box in the Sheet 
Options group. 

Add Print Titles 

1. Click on the Page Layout tab and 
click on the Print Titles tool. 

2. Click in the Rows to repeat at top text box and 
select the row(s) on the worksheet to repeat. 

3. Click in the Columns to repeat at left text box and 
select the column(s) to repeat. 

4. Click on the Print Preview  or Print 

 button. 

 Freeze Panes 
1. Select the cell below the rows and to the right 

of the columns you want to freeze. 

2. Click on the View  tab. 
3. Click on the Freeze Panes tool in the 

Window group and select Freeze Panes.  
Click the Freeze Panes tool and select Unfreeze 
Panes to clear. 

Split Screen  

1. Click the View  tab and click on the 

Split  tool in the Window group. 
You can drag the splitters to a different location. 

2. To remove the split, click on the Split  
tool or double-click on each splitter. 
You can also drag the horizontal splitter above 
the vertical scroll bar or the vertical splitter to the 
right of the horizontal scroll bar to split the 
screen. 

Remove Unwanted Rows/Columns 
To remove unwanted blank rows and/or columns 
at the end of a worksheet: 

1. Select the first blank row heading to highlight 
the entire row. 

2. Hold down the [Shift] key and drag the scroll 
box (located on the vertical scroll) bar to the 
bottom of the vertical scroll bar.  

3. Hold down the [Shift] key and click on the last 
row heading to select all the blank rows. 

4. Right-click on any row heading and select 
Delete from the shortcut menu. 

5. Press [Ctrl]+[Home] to go to the beginning of 
the worksheet. 

6. Press [Ctrl]+[S] to save the workbook. 
7. Press [Ctrl]+[End] to go to the end of the 

worksheet. 
 The blank rows and columns are removed and 

the cell pointer is positioned in the last cell 
containing data in the worksheet. 

Create the Default Chart Type 

1. Select the source data (the range to chart). 
2. Press [F11] to insert the default chart type on a 

new worksheet.  

Change the Default Chart Type 
1. Click on the Chart area (the empty white space 

surrounding the chart) to select the chart. 
2. Click on the Design tab under 

the Chart Tools tab.  
3. Click on the Change Chart Type tool in  

the Type group. 
4. Click on the Set as Default Chart  

button and click on OK. 

Save a Custom Chart as a Template 
1. Click on the Chart area (the empty white space 

surrounding the chart) to select the chart. 
2. Click on the Design tab under 

the Chart Tools tab.  
3. Click on the Save As Template tool in  

the Type group. 
4. Type a filename in the File name:  

text box and click on the Save tool. 

Create a Chart Using a Saved Template 
1. Select the source data (the range you want to 

chart) and click on the Insert  tab. 

2. Click any tool in the Charts  

group and select All Chart Types… 

3. Click on the Templates folder in  

the upper left corner of the Insert Chart 

dialogue box. 

4. Select your template and click on OK. 

Move a Chart to a New Worksheet 
1. Right-click on the chart area and select Move 

Chart. 
2. Select the New sheet option button, enter a 

new worksheet name and click on OK. 

Convert a file to the 2007 Format 
1. Click on the Microsoft Office button and  

select Convert.  

A dialogue box displays indicating the workbook 
will be coverted to the new format which will 
enable all new features. The original workbook 
will be deleted and cannot be restored. 

2. Click on OK to convert the workbook. 

Customize the Quick Access Toolbar  
 Includes the Save, Undo, and Redo/Repeat 

tools by default.  
 Undo levels have been increased to 100 and 

you can undo actions after you save the 
workbook.  

1. Right-click on any command in the Microsoft 
Office button or any tool on a Ribbon and 
select Add to Quick Access Toolbar.  

Or right-click on the Quick Access toolbar and 
choose Customize Quick Access Toolbar… to 
add your favorite tools.  
 Right-click a tool on the quick access toolbar 

to remove. 

Scroll box 

Quick Keystrokes 
 AutoSum  [Alt] + [=] 

 Beginning of row  [Home] 

 Beginning of Worksheet  [Ctrl] + [Home] 

 Bold  [Ctrl] + [B] 

 Copy   [Ctrl] + [C] 

 Copy Cell Above  [Ctrl] + [D] 

 Cut  [Ctrl] + [X] 

 Date (Insert)  [Ctrl] + [;] 

 Delete Cell Contents  [Del] or [Backspace] 

 Edit Mode  [F2]  

 End of Worksheet  [Ctrl] + [End] 

 Fill Down (Range)  [Ctrl] + [D] 

 Find  [Ctrl] + [F] 

 Formulas (Display)  [Ctrl] + [`] 

 GoTo  [Ctrl] + [G] 

 Italic  [Ctrl] + [I] 

 Next Worksheet  [Ctrl] + [Page Down] 

 Open  [Ctrl] + [O] 

 Paste  [Ctrl] + [V] 

 Previous Worksheet  [Ctrl] + [Page Up] 

 Print  [Ctrl] + [P] 

 Replace  [Ctrl] + [H] 

 Save  [Ctrl] + [S] 

 Select All  [Ctrl] + [A] 

Select Range (Column) 
 [Ctrl] + [Shift] + [↓] 
 [Ctrl] + [Shift] + [↑] 

Select Range (Row) 
 [Ctrl] + [Shift] + [→] 
 [Ctrl] + [Shift] + [←] 

 Time (Insert)  [Ctrl] + [Shift] + [;] 

 Underline  [Ctrl] + [U] 

 Undo  [Ctrl] + [Z] 

 Wrap Text  [Alt] + [Enter] 
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